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Preface 
 
 Probably you know already some applications which you can use to create your own 

compact discs. Helios is such a program, too. With Helios you are able to make regular 
compact discs (CDs) which can contain data as well as audio tracks. With Helios you 
are able to create all kinds of disc media used in the most cases. That means Helios is 
dedicated to users who want to make their own audio CDs or make some backup 
copies. Of course, there are more things possible to do with Helios... 
   The process of burning an entire disc is a more complex one. Due to a large variety 
of different settings there are many ways how a disc can be written. Helios tries to 
make this as easy as possible, but also provides the most important features of any 
other good disc recording program. 
 

 Helios has an integrated project manager. This allows to save and load disc projects at 
any time. Such projects contain information about the used file system, volume name 
and about the disc type and settings. Saving your project is useful when you want to 
burn a disc not at the same time when you know what the disc should contain. Projects 
are often used, when a disc has to be created more than one time on different days or 
computer systems. But you do not need to create a project in order to burn a CD with 
Helios. 
 

Text beside that white-orange coloured "E" describes things more detailed and goes 
more deeply into the system. It is nothing really important and may be ignored. 

 
Text written in italic letters is exactly the same which can be found in the application 
(ex: Open Project, Burn Now!, ...). 
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A INTRODUCTION 
 
 
 
Which software do I need to make it work? 

 
Since Helios is an application for the Be Operating System (BeOS) you need BeOS 
in order to run and use Helios. The BeOS is available at www.gobe.com. 
There are two different versions of BeOS available: The Personal Edition which is for free 
and the Professional Edition which is the commercial version with more features. Be 
sure you have one of these. 

 
 
Hardware requirements 
 

• system with a working BeOS installation on a hard disk 
• CD recording device 
• 2MB of free space for Helios 
• at least 1GB of free space for copying and writing CDs 

 
 

Notes 
 
 The following folders/files must exist in your system: 

• /boot/home/config/settings/ 
• /boot/beos/bin/cp 
• mkbfs (anywhere on the disk) 

 
Otherwise Helios will not work properly. 

 
/boot/home/config/settings/ contains a file named "Helios.settings" after the first time 
Helios is launched. The copy command is needed for copying files into a 
BFS-image. If mkbfs cannot be found in /boot/beos/bin/ a small window does 
pop up at program start and searches the boot partition for it. This is done for 
the cdrtools, too. 
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B INSTALLATION 
 
 
 
Install Helios via SoftwareValet 
 

First at all, you need the package file containing the Helios application and tools. The 
package is available at www.bebits.com. You can use NetPositive, the BeOS browser, 
to download it. The original web site of Helios is home.arcor.de/moscht/BeOS/. 

 
In your "Downloads" folder you can see a file named 
"Helios_x.x.pkg.zip" or similar. 

 
 
 

Launch it and an utility program 
will be launched, commonly this 
is the BeOS "Expander". Simply 
press the Expand button. A new 
file is created in the same folder, 
but in its name the ".zip" 
extension is missing. (The icons 
shown in the pictures may vary 
on other systems.) 

 
 
 
 
 

Now launch the new created file. The window of the 
SoftwareValet application appears and lets you 
choose a directory where you want to install Helios. 
If you do not know where to install, simply press 
Begin and SoftwareValet will install Helios in the 
user's application folder. There also may be 
more than one installations available as 
seen in the picture. In the box labelled 
Group Information you can see a 
description of the currently selected 
installation. In the top area of the window 
(which is empty in the picture) can be 
found some information about the current 
version of Helios which mostly applies to 
this version, only. 
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To start installation process, click the 
Continue button. The SoftwareValet 
program lets you know when the 
installation has been finished. Then, Helios 
is installed and ready for use... 

 
 

 
 
 
 
 
 
 
 
 
 

Notes 
   

The Helios Installer does not create links neither into the Be-menu nor on the Desktop. If you 
prefer to have such links, you can do that manually which is very easy. The Be-menu links 
reside in /boot/home/config/be (and sub-folders). To create a link in there, just drag & drop 
the Helios icon from the Tracker's window showing the Helios folder into 
/boot/home/config/be or one of its sub-folders. The link appears immediately after this in the 
Be-menu. 

 
 

Uninstall Helios 
 

To remove Helios from the system, you can choose between a number of possible 
ways. But in common, these things have to be removed: 
• The application folder of Helios (/boot/apps/Helios/ in the most cases) 
• The project files (in /boot/Helios/ or in another folder, specified by you.) 
• Any temporary files (in /boot/home/ or in another folder, specified by you.) 
• The cdrtools which came with Helios (in /boot/home/config/bin/ or in other folders 

specified by you.) 
 

The cdrtools could be used by other programs, too. If you are unsure whether you 
should remove these files, it is safe to leave them on the disk. 

 
As an alternative, the SoftwareValet program can be used for removing, too. 
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C THE GRAPHICAL USER INTERFACE 
 
 
 
The main window 

 
After you launch Helios you can 
always see the main window 
which looks like the window at 
the right side. It consists of four 
parts: The main disc settings box 
at the left top, the info box 
below the disc settings and the 
file list at the right. And, of 
course, the menu bar at the very 
top of the window. 
 
 
The disc settings box contains the most important and more often used settings for all kinds 
of disc modes supported by Helios. In the upper part of the box-frame a small menu is 
integrated (in the picture it is displaying Data CD). With this small menu you can select a disc 
type such as Data CD, Audio CD and so on. The content of the disc settings box changes as 
the disc type is changed to display only the necessary and for the disc type appropriate 
settings. 
 
 
This box which is located directly below the disc settings box does contain information about 
the current project. The Total CD Size row displays always the disc size in MB. This is the size 
of the file system image when making data CDs. But it is the size of real audio data when 
you have an audio CD project loaded. The Total CD Duration line shows the playing time of 
the disc. This is more useful for audio CDs than for data CDs, since data discs do not really 
play on audio CD players. The line Estimated Time shows the time which seems to be needed 
for the project to burn on a disc. The value calculated is not accurate and you should not rely 
on this. Especially when using a fast CD recorder the estimated length of the burning process 
is often incorrect. 
   The last two lines have the simple task of counting the total number of files and folders in 
the project you have loaded. 
 
The values shown in the info box are updated when you press the Update button. If you 
own a faster computer, you can also let Helios do this for you with a predefined update 
frequency. How to enable this feature is described more closely in chapter C The settings 
window in this document. 
 
The Update button may by located somewhere else in later versions of Helios or even might 
be replaced or removed.  
 
 
Probably the most used part of the program when creating CDs. It is the area of the main 
window where you can drop any file you want to see on your CD. Helios does not have its 
own file browser. But Helios accepts any file dragged from any Tracker window on the Helios 
main window (except when you have opened an audio project but drop a non-audio file 
type). 
 
A file which is part of the project (and therefore can be displayed in the file list) is not a 
static item which cannot be changed. The file's name can be edited just like it is done in a 

THE DISC 
SETTINGS BOX

THE INFO BOX

THE FILE LIST



Tracker window. Removing a file is done by selecting it and pressing "Del" on your keyboard. 
This applies to multiple selections, too. 
 

Renaming does change the name of the link in the project's folder but not the real file's 
name itself. The same thing with removing items from the list: Only 
the link will be removed, not the file itself. 

 
Items in a data CD or bootable CD file list can be right-clicked. If you do so, a small menu 
appears beneath the mouse cursor which contains also a New Folder menu item. Choose this 
when you want to create a sub-folder in your project. 
 

The folders are always created in the project folder.  
 

 
The file list frame has the same features as a Tracker window. Clicking on the lower left 
status display brings up a list with the parent folders. Sorting can be managed through the 
column labels at the top of the list. These features are available when data CD type or 
bootable CD type has been selected in the disc settings box. Audio tracks cannot be sorted. 
To change their order you have to drag them to another position in the list. 
 
 
The fourth part of the main 
window is – as mentioned above 
– the menu bar. It resides in the 
upper area of the window. As all 
menu bars Helios' one has several 
items in there. We will go from 
the left to the right and start with 
the File menu item. The File menu 
contains all project actions like 
open and save. 
They are almost self-explaining:  
• New Project (ALT+N) creates a completely new project and resets all settings to its 

default values (which can be configured separately in the settings panel). 
• Open Project... (ALT+O) opens a file panel where you can choose the project file directly 

and  
• Open Recent Project results in a sub-menu where the ten most recently used project files 

are listed. The list of the recent projects may contain disabled menu items (they are 
colored light-grey) which are recently used, but already deleted and no more loadable. 

• Save Project (ALT+S) saves the current project. When you save an unnamed project a file 
panel pops up and asks for a name of the current project. 

• The Export menu item is a sub-menu with file formats. Select one of them and the 
opened project will be written to a new file containing the selected file format. 

• An important item in the File menu is the Settings... (ALT+P) item. The settings panel will 
be opened when you click on this. To read more about the settings window see chapter 
C The settings window. 

• The sub-menu Log Window provides access to the log windows which display the output 
of a command line tool. For example, the "cdrecord log window" displays the output of 
cdrecord which would be normally visible in a Terminal, only. More about the log 
windows in chapter C Log windows. 

• To get information about the application (i.e. Helios) click About... and there will be 
displayed something appropriate. 

• At the bottom of the list of items in the File menu you can find the Exit item which 
closes Helios and saves all configuration settings to disk. 

 

THE MENU BAR
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BLANK CD-RW

The Image menu contains all 
about file system images. 
• Read CD Image... (ALT+R) 

simply reads the whole CD 
inserted in the reader device 
and writes it to the file which 
must be entered in the small 
window which appears after 
clicking this menu item. 

• Create Image File... (ALT+F) 
writes the project as a file 
system image file. This can be useful when you want to write the CD with another CD 
burning application which supports image writing (CD Manager and CDBurner, for 
example). 

• Burn Image File... (ALT+B) is to write an image file directly to a recordable compact disc. 
Just imagine you got an such an "ISO" image from the internet and want it on a CD to 
get a disc which is nearly the same as the original one where the "ISO" is from. 

 
 
The third menu in the main menu 
bar from the left is the Copy CD 
menu. The items in this menu 
may vary in future versions. 
However, in the picture at the 
right you can see the two most 
important options. 
• Copy Audio CD copies a 

audio disc but no CD Extra or 
any other multisession disc. 

• Copy Data CD copies a data 
disc but takes no care about bootable CD's extra sessions. In common, multisession discs 
cannot be copied by Helios, yet. 

 
 
The last menu is the Blank CD-
RW menu which lets you erase a 
rewritable disc. Four modes (out 
of some more supported by 
cdrecord) are shown in the menu 
list: 
• Entire CD (fast) erases the 

table of contents of the disc. 
As this table is very small in 
comparison with the real data 
on the disc the erasing 
process lasts not very long, even when using an older CD recorder device. This is also the 
recommended mode for erasing CD-RW discs. All session on the disc will be erased. This 
process and the following three ones cannot be reverted by Helios. 

• Entire CD (complete) erases the table of contents but does also overwrite the data of the 
disc. 

• Open Last Session makes the last written session usable for new data. This is only useful 
for multisession discs. 

• Erase Last Session makes the data of the last session of disc unusable and so deletes it. 
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The settings window 
  

The settings window provides 
access to all other configuration 
controls available in Helios. The 
window is divided into two parts: 
At the left you can see a list of 
categories and at the right the 
controls for the selected settings 
category. Control panels which 
appear at the right become visible 
when you click one of the sub-
categories from the list. The top-
most available control panel is 
labelled Cdrecord Switches. It 
contains only controls for modifying the options passed to cdrecord when burning or 
blanking a disc. In detail these controls are: 
• Simulation turns off the laser. Nothing will be written to the disc. 
• Fixate should be enabled since the fixation makes the disc usable. 
• BurnProof is a buffer under-run protection developed by Sanyo. Enable this feature only 

if your recorder supports BurnProof. Other protection systems like JustLink are enabled 
automatically when using cdrecord until version 1.11a35. 

• Force RW-erasing tries to erase inserted RW discs even if they are damaged (by laser 
light). Enable this when your discs are not erased with the normal (or fast) RW-erasing 
mode from the Blank CD-RW menu. 

• Disc-at-Once burns every disc in DAO mode instead of using TAO. Very old recorders do 
not support DAO or are not supported by cdrecord. 

• allow CDs > 80 min disables cdrecord's internal size limit for image file sizes. This will try 
to burn images which are even larger than 700 MB/80m. 

• Recording Speed lets you select the speed at which your discs should be written. If you 
want to burn at maximum speed try to drag the slider to the right. In the example 
picture this would be 48x writing. The most disc recorders will use their maximum speed 
if a higher speed than supported is selected. 

• FIFO Buffer Size is the size of the stream buffer of cdrecord. Changing the FIFO buffer 
size to higher values makes sense when using Streaming in the General panel, only. 4 
MB is the default value. If you experience problems with streamed burning change the 
FIFO buffer size to higher or lower values. 

  
 

Device specific configuration 
setting can be done in the 
Devices panel. It contains the 
following things: 
• CD Writer contains all devices 

in its pop-up menu which 
has been found at program 
start-up. Here you can 
choose your favourite disc 
recording device. Mark the 
Eject check box if you want 
Helios to open the CD tray 
after it has operated on this 
device. 

• CD Reader is similar to the CD Writer option but applies exclusively to the device you 
want to read from. 

CDRECORD 
SWITCHES

DEVICE 
SETTINGS



• 2-Drive-Copy, also called "burning on the fly", tells Helios whether you want to use two 
drives for copying or only one drive. With two drives reading and writing is done at the 
same time. With only a single drive the source disc must be read and after this the 
destination disc is written in the device specified by the CD Writer control. 

 
 
 Helios uses some special 

folders where it places temporary 
files and project files. You can 
change the names of the files and 
folders with the controls on the 
Files & Folders panel. 
• The Project Path is the path to 

the folder where the open 
and the save panels are 
opened. New projects are 
placed always in the project 
path. 

• For disk space management 
purposes you can also change the Temporary Path where mainly the file system images 
are stored. This folder should reside on a disk with at least 1 GB of free space. 

• If you create an image file the name entered in the Default Image File Name field will be 
used for the file name. 

• The Default Mount Point is a folder in the root directory where BFS image files are 
mounted. 

 
  

In every ISO9660 compliant 
image file there is space for 
information about the data it 
contains. The three most useful 
fields can be changed and 
entered into the fields of the 
Images panel. 
• The CD Publisher field 

contains information about 
the publisher of the disc, 
which contains the image 
file. 

• Some information about the 
preparer of the CD can be entered into the CD Preparer text field. 

• The CD Application field contains information about the application on the CD. 
Each field can hold a maximum of 128 characters. The text on this panel is project 
dependent and is stored into every project file. Also see chapter C The settings window/New 
Project. 
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When a new project has been 
created there are several values 
which are set by Helios for you 
as a standard for every new 
project. You can adapt these 
predefinitions to your personal 
needs. You know already the 
first three input fields. Their 
meanings are described in 
chapter C The settings 
window/Images. The Project 
Path and the Temp. Path are also 
familiar to you. The File System 
pop-up menu and the Volume Name text field are used for data CD and bootable CD mode, 
only. The CD Type menu contains all available disc modes. The marked mode is the one used 
for every new project. 
 
 
Helios can be a very patient 
application. There are many 
processes where time outs are 
built in. Just think of pressing 
the Burn Now! button without 
having inserted a disc. To 
prevent an alert message in this 
situation, Helios waits until a 
disc is inserted or there is a time 
out. The length of the time 
which Helios waits can be 
adjusted with the slider 
Timeouts which is beneath the 
Update Infobox Automatically slider. The slider at the upper area of the settings panel can be 
used to change the frequency of the automatic info box refresh. The default value is 90 
seconds. This means, the info box computes its displayed values every 90 seconds. If this 
feature is turned on and you manually refresh the content of the info box (through the 
Update button) the next automatic refresh will be 90 seconds after the button has been 
pressed. In other words, the "internal clock" which counts from 0 to the time out value (ex: 
90s) is set back to zero when the Update button is pressed or any other event causes an 
refresh of the info box. One of these "other events" is for example when you drop a file into 
the main window. 
 

The automatic info box update is suspended while Helios receives and processes a 
BMessage. I. e. when cdrecord or any other cdrtool is running. 
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Since burning a CD takes some 
time you might want to leave 
your computer alone while it is 
writing a disc. But how do you 
know when Helios has finished 
writing your CD? 
For this reason Helios has this 
Sounds panel. It has the 
following controls: 
• Beep When Finished 

Recording Disc: This does 
play the beep-sound not only 
after writing a disc, but also 
after erasing a rewritable disc. The sound sample file for the beep can be selected and 
changed through the Sounds preferences panel of the BeOS. 

• Beep When Finished Creating Image: Beeps every time an image file is completely 
written to disk. 

• Beep When An Error Occurs: Plays a user-defined sample every time a message box 
describing an error is shown. 

 
 
The more application specific 
settings can be found in the 
General panel: 
• Data Streaming: When 

burning a data disc of files 
which are on a hard disk, 
there must be created an 
image file at first. Then this 
image file can be written to 
the disc. There are two 
possibilities how a CD can be 
recorded: Either, Helios 
creates the image file and 
stores it on a hard disk and after this Helios burns the image file. Or, Helios creates the 
image file but burns the image file which is just written to the disc at the same time. The 
first way is with Data Streaming disabled and is very safe. The second way is without 
Data Streaming and may cause buffer under runs on slow computers but safes very 
much time. 

• Remember Last Project: When Helios is launched, it loads the last project loaded 
automatically if this option is enabled. If disabled, Helios starts with a new (empty) 
project. 

• On Exit Do...: 
• Save Project Without Asking: When the Helios application is closed all changes to 

the current project are saved. Helios quits immediately after it has saved the 
project. 

• Ask Whether Project Should Be Saved Or Not: When Helios is closed you are 
asked if you want to save your project before Helios is exiting. 

• Nothing. Just Quit.: If selected Helios does nothing when it is closed. Nothing is 
saved except the configuration data. The project opened at that time is not 
saved. 
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• Enable InfoBar: Enables support for the InfoBar 
application written by Jens Tinz. The InfoBar 
provides context sensitive help for controls where 
the mouse cursor is located. It is something like a 
replacement for a small documentation. See the 
picture at the right for more information about 
it. 

• Select Language: This control is for changing the 
language which is used in Helios. After changing 
the language you have to restart Helios to see the changes. 

 
It is possible to add more languages to Helios. There is a tool which makes translation 
very easy: The "Helios Language Manager" application is available at www.bebits.com. 
 

 
On the "version info" settings 
panel the version numbers of the 
cdrtools and Helios are shown. 
Sometimes it is important to 
know them for compatibility 
issues. As you can see on the 
picture at the right, the version 
information of "cdda2wav" could 
not be determined. The reason is 
that cdda2wav does not support 
the "--version" flag in former 
versions. Please keep in mind 
that alpha version (indicated by 
an "a" or "alpha" in the version number) are not tested and may not work properly. If you use 
older versions of cdrtools some options of Helios might not be available. 

 
 

Log windows 
  

Some problems with the cdrtools 
but also with Helios can 
sometimes be solved very easily if 
the output of cdrecord (and 
sometimes of mkisofs, too) is 
available. Thus, the output of 
these two command line 
applications can be accessed 
through Helios in a very 
comfortable way. The File menu 
of each window contains two 
functions: Firstly the Clear command and secondly the Close item. Clear does empty the 
displayed text, only. The data which is redirected to a log file is not touched by this. The file 
itself to which the output can be redirected can be chosen by clicking Set File... in the Log 
File menu. Logging to a file can be enabled and disabled with the Log To File option in the 
same menu. The file name is remembered by Helios even when logging to file is disabled. 
Cdrecord's log window has exactly the same behaviour as mkisofs' ones. The two log 
windows are shown on the next page. 
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The status window 
  

While Helios is busy a small 
window is visible which shows a 
green bar indicating the 
progress. The bold printed text 
above describes what Helios (or a 
tool in the background) is doing. 
Right between the bold text and 
the status bar are two small text 
fields: The left one is visible when 
burning a CD only, but the 
second one at the right shows 
some more information than the green bar could do. Usually it displays something like "x 
MB/s" or "12s". 
   The button at the bottom right is always the Cancel button. To kill a running process press 
this button. Helios then tries to stop as soon as possible the process. While burning a CD, 
pressing this button may turn the disc unusable and the CD drive permanently locked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



D GLOSSARY 
 
 

 
Be-menu 
 The menu which appears when you click at the top of the DeskBar (where the BeOS logo 
 is). 
 
BFS 
 (Be File System) A file system created by Be used by the BeOS. It is a fast and very safe file 
 system supporting fast file search and attributes. 
 
BurnProof 
 (Buffer Underrun Proof) A function which tries to avoid an empty buffer while burning a 
 CD. Empty buffers are caused by slow hard disks and busy busses. 
 
CD 
 (Compact Disc) A thin disc on which you can store digital data. 
 
CD-R 
 (CD-Recordable) A compact disc which can be recorded once. 
 
CD-RW 
 (CD-ReWritable) A compact disc which can be recorded and erased many times. 
 
DAO 
 (Disc-At-Once) The preferred way how a CD can be recorded. The data is written to the 
 disc at once and cannot be written again. 
 
FIFO 
 (First-in, first-out) A buffer used for streaming data. The items which are inserted first will 
 be the ones which can be read first (which leave the buffer). 
 
File Allocation Table 
 A table with the filenames and sector information of every file on the file system. 
 
File System 
 The way how data is stored on a disk. In common, file systems consist of a file table and a 
 data area. The file table (also called file allocation table, FAT) contains file names and 
 references to the area where the files are stored in the data area. Popular file systems are 
 FAT12 (used for floppy disks), FAT16 (used by DOS), FAT32 (used by Windows), NTFS 

  (used by Windows NT), BFS (used by BeOS), ... 
 
Image, Image File 
 A regular file on a file system which contains another file system. With BeOS and Unix-like 
 operating systems such image files' data can be accessed easily. An image file can be 
 written to a CD which represents the file system inside the former image file afterwards. 
 To copy a CD, the image of a CD can be read and stored to hard disk as an image file. 
 Then this file can be written to another disc. The source disc and the second one contain 
 the same data and the same file system. 
 
JustLink 
 A buffer underrun protection mechanism by another manufacturer. The result is almost 
 the same as it is with BurnProof. 
 



to Mount 
 Mounting a disk means to make a disk's content readable and, if allowed, writable. Disks 
 not mounted at a mount point cannot be accessed by applications through the operating 
 system. All more sophisticated operating systems provide this system. 
 
Mount Point 
 A folder which looks like a regular one to the user where devices can be mounted. 
 

 Multisession 
 Another way how a CD can be filled with data more than once. Usually, when creating a 
 multisession disc, you write one or more sessions onto that disc. And if you think you 
 have forgotten something, the disc can be filled with data again which is appended to 
 the data which is already on the CD. 
 
Sounds 
 An application shipped with BeOS. With Sounds you can change the system's sounds and 
 the sounds used by applications. You can find the Sounds application in the Be-menu. 
 
TAO 
 (Track-At-Once) Another way how a CD can be recorded. Single tracks are written to such 
 a disc. Other tracks can be added afterwards. 
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Last modified: Oct 13, 2002 
This document was designed and written by Maurice Michalski 
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